
Report Creation Software
for North America

Operating Instructions

English



Report Creation Software Operating Instructions

2-EN
Contents

1 Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

2 Operating environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

3 Installation precautions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

4 Report Creation Software features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

4-1. Checking previous reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

4-2. Creating monthly and daily reports automatically . . . . . . . . . . . . . . . . . . . . . 6

4-3. Creating summary sheets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

4-4. Displaying monthly reports, daily reports and summary sheets . . . . . . . . . 8

4-5. Setting report items and distribution for each system  . . . . . . . . . . . . . . . . . 9

4-6. Checking the software run history. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

4-7. Checking the version information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

4-8. Minimizing the window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

5 Using Report Creation Software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

5-1. Starting up and exiting Report Creation Software . . . . . . . . . . . . . . . . . . . . 13
5-1-1. Starting up Report Creation Software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

5-1-2. Exiting Report Creation Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

5-2. Registering target system information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

5-3. Adding a target system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

5-4. Editing a target system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

5-5. Deleting a target system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

5-6. Changing the display format of the registered systems list . . . . . . . . . . . . 25

5-7. Creating monthly / daily reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

5-8. Recreating monthly / daily reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

5-9. Creating summary sheets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

5-10. Displaying monthly reports / daily reports / summary sheets  . . . . . . . . . . 35
5-10-1. Displaying monthly reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

5-10-2. Displaying daily reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

5-10-3. Displaying summary sheets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

5-10-4. Hiding the header and footer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

5-10-5. Printing the displayed report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

5-10-6. Viewing a print preview of the displayed report  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

5-10-7. Displaying multiple report windows  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

5-11. Changing the software display language . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

5-12. Deleting the software run history. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

5-13. Copying files from external media . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

6 The automatic download function . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46



Report Creation Software Operating Instructions
7 The backup function . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

7-1. Registering target system information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

7-2. Adding a target system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

7-3. Editing a target system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

7-4. Deleting a target system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

7-5. Changing the display format of the registered systems list . . . . . . . . . . . . 54

7-6. Performing manual backup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

8 Cautions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

8-1. “** exception **” and “** no name **” on the monthly report screen . . . . . 57

9 License agreement  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
3-EN



Report Creation Software Operating Instructions

4-EN
1 Overview
“Report Creation Software” is software that creates monthly reports based on the operation results of individual air conditioning 
units within the air conditioning control system. The software also includes electrical power distribution and charge calculation 
functions.
The electrical power distribution function distributes the amount of electricity used for each air conditioner, based on the power 
meter pulse-integrated value measured in the air conditioning control system.
The charge calculation function calculates the charge for each air conditioning unit based on the electric unit price and the 
amount of electricity distributed to each air conditioner.
Files can be saved in Excel, CSV and PDF formats.

CAUTION
• Using the accumulated power meter with pulse output, the system calculates the distribution of power accumulated by pulse 

conversion according to the load proportion estimated for each air-conditioner. The result is not calculated based on the 
Measurement Act and cannot be used officially.

• Even if the operation hour is the same, the amount of power consumed varies depending on operating conditions such as 
the location of the air-conditioner, the set temperature, and the outdoor temperature.

• The air-conditioner stays on for protection, even while stopped, and power is consumed. Therefore the system also 
calculates power consumed while the air-conditioner is not in use.

• The system calculates the distribution of power according to the load proportion estimated for each air-conditioner. 
Therefore the result may differ from the actual amount of power consumed.

• If a single power meter is installed in multiple air-conditioners, the total power is distributed. The result may differ when a 
power meter is installed in each air-conditioner.

• The system calculates the pulse output using the accumulated power meter with pulse output. The result may differ from 
the actual amount of power consumed depending on the precision of the power meter. In particular, when the amount of 
electricity consumed in operation is low (when stopped, etc.), the result may differ from the actual amount of power 
consumed.

• Please note that we bear no responsibility for any damage or problems that occur due to the system’s distribution 
calculation, data loss, etc.

• The calculation result contains rounding errors.
• The system only supports the distribution calculation of power consumed by the air-conditioner. Please note the above 

when you use it.

2 Operating environment
The following is the ideal operating environment for this software:

The runtime library below is installed before Report Creation Software is installed.
• Microsoft®.NET Framework 4.0
• “Windows 7”, “Windows 8” and “Microsoft Office” are trademarks or registered trademarks of Microsoft Corporation in the 

United States and other countries.
• Adobe, the Adobe Logo, Adobe Reader and Adobe Acrobat are trademarks or registered trademarks of Adobe Systems 

Incorporated in the United States and other countries.
• Install Shield is a trademark or registered trademark of Flexera Software Inc. in the United States and other countries.
• All company names and product names that appear in this manual are trademarks or registered trademarks of their 

respective holders.
In this manual such names are not indicated by ® or © marks.

3 Installation precautions
If a previous version of this software (Monthly Report Creation Software, Data Download Software) is already installed, uninstall 
it first, and then install Report Creation Software. If the previous version of the software is not uninstalled, Report Creation 
Software may not work properly.

Item Necessary environment

Operating System Windows 7, Windows 8

Office System Office 2007, 2010, 2013
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4 Report Creation Software features

4-1. Checking previous reports
Previous reports (monthly reports / daily reports / summary sheets) can be checked on the main screen. Click the monthly 
calendar / daily calendar button, select Creation history of summary sheet, or click View report in the [Run] menu to display 
previous reports.

Fig.4-1 [Main screen]

The month / date buttons are displayed in 2D or 3D. The display format changes according to the availability of downloaded or 
previously created monthly report (including manual meter readings) or daily report files.

Table.4-1 [2D/3D display of month / date buttons]

The background colour of the date button changes according to the selected monthly report closing dates.

Table.4-2 [Date button colours]

Date buttons are underlined when there is a manual meter reading daily report file for that date.
(Only for – Type: Touch Screen Controller / Model: BMS-CT5120)

Format Display conditions Button selection

2D When there are no downloaded files or previous report files. Not selectable

3D When there are downloaded files or previous report files. Selectable

Not a monthly report closing date Monthly report closing date

Monday to Friday Saturday / Sunday
First selected 

monthly report 
closing date

Second selected 
monthly report 

closing date

Background colour Grey Dark grey Green Orange

Hover the mouse over the month to see 
how many Monthly reports and Manual 
meter reading files can be downloaded.

3D display

2D display

There is a manual meter reading 
daily report file.

Refresh the display
5-EN
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4-2. Creating monthly and daily reports automatically
When “Automatic download” is selected during system registration, monthly and daily reports are automatically created at the 
set “Time of automatic download”.

Fig.4-2 [The system registration screen]

The following formats are available: Excel (extension: xlsx), CSV (extension: csv) and PDF (extension: pdf*3). Created files are 
as follows:

Table.4-3 [Created files]

*1. When two meter readings are performed each month, the first meter reading is the “First monthly report closing date meter 
reading file”, and the second is the “Second monthly report closing date meter reading file”. When there is only one meter 
reading per month, only the “First monthly report closing date meter reading file” is created.

*2. “nn” represents the number of readings performed in the same month (the first reading is 01, the second reading is 02, etc.)
*3. “_L” is added to the PDF file name of the list, “_SS1” to summary sheet 1, and “_SS2” to summary sheet 2.
*4. “aa” and “bb” of the file name stand for the manual meter-reading No. (start/end) selected on the Selecting the term for 

summarizing start date screen. “cc” and “dd” stand for the manual meter-reading No. (start/end) selected on the Selecting 
the term for summarizing end date screen.
(Only for – Type: Touch Screen Controller / Model: BMS-CT5120)

No. File name File name format Example file name Notes

1
First monthly report 
closing date meter reading 
file

M_YYYYMM.(extension) For September 2013 - M_201309.(extension) *1

2
Second monthly report 
closing date meter reading 
file

M_YYYYMM_A.(extension) For September 2013 - M_201309_A.(extension) *2

3 Manual meter reading file M_YYYYMM_nn.(extension) For September 2013 - M_201309_01.(extension) *2

4 Daily report file YYYYMMDD.(extension) For September 1st, 2013 - 20130901.(extension)

5 Summary sheet file
YYYYMMDD_aabb-YYY

YMMDD_ccdd.(extension)
For September 1st to 2nd, 2013,
20130901_0000-20130902_0000.(extension)

*4

Select
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4-3. Creating summary sheets
A summary sheet for a specified period can be created using daily reports created on a target system.

Fig.4-3 [The create summary sheet screen]
7-EN
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4-4. Displaying monthly reports, daily reports and summary sheets
Monthly reports, daily reports and summary sheets can be displayed. Multiple reports can be displayed, and they can be 
displayed side by side for comparison.

Fig.4-4 [The view report screen]
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4-5. Setting report items and distribution for each system
The items included in reports and the power distribution function can be set for each system.

Fig.4-5 [The system registration screen]
9-EN
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4-6. Checking the software run history
To check the software run history, click the History menu item in the [Tools] menu on the main screen to display the history 
screen.

Fig.4-6 [Tools menu (History)]

Fig.4-7 [The history screen]
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4-7. Checking the version information
Click About... in the [Help] menu on any screen to display the current software version.

Fig.4-8 [Help menu (About...)]

Fig.4-9 [The version information screen]
11-EN



Report Creation Software Operating Instructions

12-EN
4-8. Minimizing the window
Click the [Minimize] icon to minimize Report Creation Software.

Fig.4-10 [The minimize icon]

When the window is minimized, a Report Creation Software icon appears in the notification area.

Fig.4-11 [The notification area]

Double click the icon in the notification area, or right click the icon and select [Restore] to restore the window.

Fig.4-12 [Notification area (Restore)]

Click the icon
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5 Using Report Creation Software

5-1. Starting up and exiting Report Creation Software

5-1-1. Starting up Report Creation Software
Report Creation Software can be started up via the desktop icon or the Windows menu.

1 Start up Report Creation Software
• Using the desktop icon

Double click the desktop icon.

Fig.5-1 [The Report Creation Software icon]

• Using the Windows menu
In the [Start] menu, select [All Programs] > [Toshiba] > [Report Creation Software for North America] > 
[Report Creation Software for North America].

2 The startup screen appears.
When Report Creation Software is started up, the startup screen appears.

Fig.5-2 [The startup screen]

3 Report Creation Software has started up
When the startup screen (Fig.5-2) disappears and the main screen (Fig.4-1) appears, the software has 
successfully started up. The functions can now be used.
13-EN
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5-1-2. Exiting Report Creation Software
Click the [Close] icon / [Exit] menu item to exit Report Creation Software.

Fig.5-3 [Main screen (Close icon)]

Fig.5-4 [File menu (Exit)]

If the window is minimized, right click the icon in the notification area and select [Exit].

Fig.5-5 [Notification area (Exit)]

The exit confirmation dialog box may appear. Click [Yes] to exit or [No] to cancel.

Fig.5-6 [Exit confirmation dialog box]

Click the icon
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5-2. Registering target system information
When Report Creation Software is started up for the first time the target system is not registered. Follow the procedure below 
to register the target system.

1 Click the [Settings] menu item on the main screen to display the new registration screen.

Fig.5-7 [Tools menu (Settings)]

Fig.5-8 [The system registration screen]
15-EN
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2 Three types of items can be registered: System items, report display items and electrical power 
distribution items.
First, enter the system items.

Fig.5-9 [System items]

The following table shows how to enter / select each item:

Table.5-1 [How to enter / select each system item]

No. Item Data type Input / selection method

1 System Entered by user Character input

2 Type Selected by user Selected from list

3 Model Selected by user Selected from list

4 IP Address Entered by user Number input

5 Daily report closing time Cannot be entered

6 Monthly report closing date Cannot be entered

7 Automatic download Selected by user

8 Time of automatic download Entered by user Number input

9 Data save folder Entered by user Enter directly or use the [Browse] button

10 Monthly report save folder Entered by user Enter directly or use the [Browse] button
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3 Next, set the report display items.
The settings can be made on the “List” tab, the “Summary sheet - 1” tab and the “Summary sheet - 2” tab.

Fig.5-10 [Report display items]

The following items can be set:

Table.5-2 [Report items]

No. Item Description

1 Operation hours Displays the total number of operation hours calculated by combining the operation hours of in 
working hours and out of working hours.

2 Electric power Displays the total amount of electric power calculated by combining the electric power of in 
working hours and out of working hours.

3 Charge Displays the total charge calculated by combining the charges of in working hours and out of 
working hours.

4 Charge including tax Displays the total charge including tax calculated by combining the charges of in working hours 
and out of working hours.

5 In working hours display Displays the in working hours items selected from the following list: Operation hours, Electric 
power, Charge, Charge including tax.

6 Out of working hours display Displays the out of working hours items selected from the following list: Operation hours, 
Electric power, Charge, Charge including tax.

7 Categories of Summary sheet 
- 1

Select from “Floor”, “Tenant”, “Area” and “Refrigerant system”. “Refrigerant system” is only 
selectable when “Proportion within refrigerant system” is selected in the Distribution result.

8 Categories of Summary sheet 
- 2 Select from the items not selected for Categories of Summary sheet - 1, or select “None”.
17-EN
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4 Next, set the items for Monthly report, Daily report and electrical power distribution when creating 
a summary sheet.

Fig.5-11 [Electrical power distribution items]

The following items can be set:

Table.5-3 [Electrical power distribution items]

Table.5-4 [Currency names and units of currency used in reports]

No. Item Description

1 Currency name Select the currency name to be used in charge results. For currency names and units of 
currency, refer to Table.5-4.

2 Subordinate currency unit Select “None” or “1/100”.

3 Tax rate Set the tax rate for consumption tax in the charge results.

4 Distribution result
Select “Electric power” or “Proportion within refrigerant system”. When “Proportion within 
refrigerant system” is selected, the Power distribution function and usage of power meter at 
power distribution cannot be set.

5 Power distribution function Select “Capacity distribution”.

6 Usage of power meter at 
power distribution Select “Distribute separately” or “Distribute total value”.

7 Calendar start day Select “Sunday” or “Monday” as the start day for the daily report selection calendar.

8 Calendar start month Select a month from “January” to “December” as the start month for the monthly report 
selection calendar.

9 Date format Select “Year/Month/Day”, “Day/Month name/Year”, or “Month name/Day/Year” for the date 
format.

Currency name Unit of currency Currency name Unit of currency Currency name Unit of currency

Japanese yen Yen Dollar Dollar Euro Euro

Pound Pound Chinese Yuan RMB Korean Won Won
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5 Finally, click the unit price for each time span (In working hours and Out of working hours) to set 
the electricity bill unit price per kWh.

Fig.5-12 [Electrical power distribution items]

6 The setting screen appears. Enter the unit price.

Fig.5-13 [Electrical power distribution items]

7 When an “IP Address” is set, click the [Check the connection] button / [Check the connection] 
menu item to check the connection for the target system.

Fig.5-14 [System registration screen (Check the connection button)]

Fig.5-15 [Run menu (Check the connection)]

Click

Click the button
19-EN
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8 If there are any errors in a registration item, an error icon appears in that item.
Hover the mouse over the error icon to view the error message.

Fig.5-16 [Error icon (when no currency name is set)]

9 When all of the items are entered properly, you can click the [Register] button / [Register] menu 
item.
Click the [Register] button / [Register] menu item to register the system information.

Fig.5-17 [System registration screen (Register button)]

Fig.5-18 [File menu (Register)]

10 Click the [Close] icon / [Close] menu item to close the system registration screen.

Fig.5-19 [System registration screen (Close icon)]

Fig.5-20 [File menu (Close)]

Error icon

Error message

Click the button

Click the icon
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11 If the system information is still being entered, a confirmation message appears.
If the [Yes] button is clicked, the entered information is discarded and the system registration screen closes.

Fig.5-21 [Confirmation message]
21-EN



Report Creation Software Operating Instructions

22-EN
5-3. Adding a target system
Follow the procedure below to add a new target system.

1 Click the [Settings] menu item on the main screen to display a list of registered systems.

Fig.5-22 [Tools menu (Settings)]

2 Click the [New] button / [New] menu item in the registered systems list screen to display the new 
registration screen.

Fig.5-23 [List display screen (New button)]

Fig.5-24 [Edit menu (New)]

Refer to “5-2.Registering target system information” to add the target system.

Click the button
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5-4. Editing a target system
Follow the procedure below on the registered systems list screen to edit the target system.

1 Select the target system to edit.

Fig.5-25 [The List display screen]

2 After selecting, click the [Edit] button / [Edit] menu item to display the edit screen.

Fig.5-26 [List display screen (Edit button)]

Fig.5-27 [Edit menu (Edit)]

Refer to “5-2.Registering target system information” to edit the target system.
When Details is selected, the system whose details are being displayed will be edited.

Select the target system to edit.

Click the button
23-EN
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5-5. Deleting a target system
Follow the procedure below on the registered systems list screen to delete a target system.

1 Select the target system to delete.

Fig.5-28 [The List display screen]

2 After selecting the system, click the [Delete] menu item.

Fig.5-29 [Edit menu (Delete)]

3 A delete confirmation message is displayed before deleting.
To delete, click the [Yes] button. The selected system will be deleted. To cancel, click the [No] button.
When Details is selected, the system whose details are being displayed will be deleted.

Fig.5-30 [Delete confirmation message]

Select the target system to delete.
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5-6. Changing the display format of the registered systems list
There are two display formats for the registered systems list.
• List display: Registered systems are displayed in a list.
• Details: Detailed information about the registered systems is displayed.

Fig.5-31 [The List display screen]

Fig.5-32 [The Details screen]
25-EN
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Click the [List display] button / [Details] button to change the display format.

Fig.5-33 [Details screen (List display button)]

Fig.5-34 [List display screen (Details button)]

When several systems are registered, click the [Previous] button / [Next] button to change the system that is being displayed.

Fig.5-35 [Details screen (Previous button)]

Fig.5-36 [Details screen (Next button)]

Click the button

Click the button

Click the button

Click the button
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5-7. Creating monthly / daily reports
In the following circumstances, monthly / daily reports may not be created automatically.
• When registering a target system.
• When automatic download is not set.
• When the PC is not turned on at the time of automatic download.

Follow the procedure below to create a monthly / daily report that was not created automatically.

1 Select the system to create the monthly / daily report for on the main screen.

Fig.5-37 [Main screen (System selection)]

2 Click the [Download & create monthly / daily report] menu item on the main screen.

Fig.5-38 [Run menu (Download & create monthly / daily report)]

3 A run confirmation message appears before the automatic process runs.
To download all necessary files, click the “□ New download” checkbox and then click the [Yes] button to start 
the download.

Fig.5-39 [Run confirmation message]
27-EN
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4 A “Running...” screen is displayed while the automatic process is running.
Wait until the process is complete.

Fig.5-40 [Running... screen]

5 If the report was created successfully, a completion message appears.

Fig.5-41 [Normal completion message]

6 If the report was not created successfully an error message appears.

Fig.5-42 [Error message (when the file could not be saved)]
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5-8. Recreating monthly / daily reports
Follow the procedure below to recreate monthly / daily reports.

1 Select the system to create the monthly / daily report for on the main screen.

Fig.5-43 [Main screen (System selection)]

2 Select the month / date to create the report for on the main screen.

Fig.5-44 [Main screen]

Click the button

Click the button
29-EN
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3 Click the [Download & create monthly / daily report] menu item on the main screen.

Fig.5-45 [Run menu (Download & create monthly / daily report)]

4 A run confirmation message appears before the automatic process runs.
To download all necessary files, click the “□ New download” checkbox and then click the [Yes] button to start 
the download.

Fig.5-46 [Run confirmation message]

5 A “Running...” screen is displayed while the automatic process is running. Wait until the process 
is complete.

Fig.5-47 [Running... screen]
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6 If the report was created successfully, the monthly / daily report is displayed.

Fig.5-48 [The view report screen]
31-EN
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5-9. Creating summary sheets
Follow the procedure below to create a summary sheet.

1 Select the system and click the [Create summary sheet] menu item.

Fig.5-49 [Tools menu (Create summary sheet)]

2 Click the calendar icons to select the starting date and ending date for the summary sheet.

Fig.5-50 [The create summary sheet screen]

Click the icon

Click the icon
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3 Select the starting date and ending date from the calendar.
As on the main screen, date buttons are underlined when there is a manual meter reading daily report file.
(Only for – Type: Touch Screen Controller / Model: BMS-CT5120)
Use the [<] [>] buttons to change the year and month, or enter a year and month.

Fig.5-51 [Calendar screen]

4 If a date with a manual meter reading daily report file has been selected on the calendar screen 
(Fig.5-51), select the manual meter reading No.
Click the [Meter reading No.] icon to select the manual meter reading No.

Fig.5-51_1 [The create summary sheet screen]

There is a manual meter reading 
daily report file.

Click the icon

Click the icon
33-EN
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5 Select the manual meter reading No. from the list and click the [OK] button to set the manual 
meter reading No. on the Create summary sheet screen.

Fig.5-51_2 [The selecting the term for summarizing end date screen]

Fig.5-51_3 [The create summary sheet screen]

6 Click the [Create] button / [Create] menu item to create the summary sheet.

Fig.5-52 [Create summary sheet screen (Create button)]

Fig.5-53 [Run menu (Create)]

7 When the summary sheet is created, it is displayed on the view report screen.

Select the manual meter reading No.

The manual meter reading No. is set

Click the button
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5-10. Displaying monthly reports / daily reports / summary sheets
To display previously created reports (monthly reports / daily reports / summary sheets), select the report to display. Next, click 
the [View report] button / [View report] menu item to display the view report screen.

Fig.5-54 [Main screen (View report button)]

Fig.5-55 [Run menu (View report)]

Fig.5-56 [The view report screen]

Click the button
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The displayed report has three tabs: “List”, “Summary sheet 1” and “Summary sheet 2”. For information about setting the items 
and summary sheet categories, refer to step 3 in “5-2.Registering target system information”.
The number of reports displayed and the number of remaining reports that can be displayed is indicated on the main screen 
status bar.

Fig.5-57 [Main screen status bar]

If the number of selected reports exceeds the upper limit (32 reports) an error message appears.

Fig.5-58 [Error message]

5-10-1. Displaying monthly reports
Follow the procedure below to display monthly reports.

1 Select the system.

2 Select the target year. Use the [<] [>] buttons to change the year, or enter a year.

3 Select the target month. (Several months can be selected at once)

4 Click the [View report] button / [View report] menu item.

Fig.5-59 [Main screen]

1

3
2
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5-10-2. Displaying daily reports
Follow the procedure below to display daily reports.

1 Select the system.

2 Select the target year and month. Use the [<] [>] buttons to change the year and month, or enter 
a year and month.

3 Select the target date. (Several dates can be selected at once)

4 Click the [View report] button / [View report] menu item.

Fig.5-60 [Main screen]

1

2

3
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5-10-3. Displaying summary sheets
Follow the procedure below to display summary sheets.

1 Select the system.

2 Select the summary sheet from the creation history of summary sheet list. (Several summary 
sheets can be selected at once)

3 Click the [View report] button / [View report] menu item.

Fig.5-61 [Main screen]

1

2
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5-10-4. Hiding the header and footer
Click the lines between the header and footer and the main text to hide the header and footer.

Fig.5-62 [View report screen (with the header and footer displayed)]

Fig.5-63 [View report screen (with the header and footer hidden)]

Click

Click
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5-10-5. Printing the displayed report
Click the [Print] button / [Print] menu item to print the displayed report.

Fig.5-64 [View report screen (Print button)]

Fig.5-65 [File menu (Print)]

5-10-6. Viewing a print preview of the displayed report
Click the [Print preview] button / [Print preview] menu item to display a print preview of the displayed report.

Fig.5-66 [View report screen (Print preview button)]

Fig.5-67 [File menu (Print preview)]

Click the button

Click the button
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5-10-7. Displaying multiple report windows
Use the [Window] menu to display multiple report windows.

Fig.5-68 [View report screen (Window menu)]

Displaying several report windows at once allows you to compare the reports easily.

Fig.5-69 [View report screen (when tiled vertically)]
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5-11. Changing the software display language
Select the display language from the [Language] sub-menu to change the software display language.

Fig.5-70 [Tools menu (Language sub-menu)]

The following languages can be selected.

Table.5-5 [Language list]

When you select the display language the message below is displayed. Restart the software and confirm the display language.

Fig.5-71 [Message displayed when changing language]

English French Spanish
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5-12. Deleting the software run history
Click the [Tools] menu item on the main screen and then History to display the History screen. Select the history to delete, and 
click the [Delete] button / [Delete selected history] menu item. If you click the [Delete all] menu item, all history will be deleted.

Fig.5-72 [History screen (Delete button)]

Fig.5-73 [Run menu (Delete selected history)]

A delete confirmation message is displayed before deleting. To delete, click the [Yes] button. The selected history will be 
deleted. To cancel, click the [No] button.

Fig.5-74 [Delete confirmation message]

Click the button Select the history to delete

Select the history to delete
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5-13. Copying files from external media
Follow the procedure below to copy files from external media.
[Note] If the external media is a Compact Flash card, use a USB card reader.
Only for – Type: Touch Screen Controller / Model: BMS-CT5120

1 After selecting the Touch Screen Controller system, click the [Copy from external media] button/
[Copy from external media] menu item.

Fig.5-75 [Main screen (Copy from external media button)]

Fig.5-76 [Tools menu (Copy from external media)]

2 A copy source selection window is displayed. A list of folders containing folders named DEF on 
the removable disk connected to the PC is displayed.

Fig.5-77 [Select the copy source]

Click the button
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3 Select the folder that contains the file that you wish to copy, and click the [OK] button. The file 
will be copied when the [OK] button is clicked.

Fig.5-78 [Select the copy source]

4 When the file has been copied, the main screen will update based on the copied file.

Click the button

Select a folder
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6 The automatic download function
This function is carried out when “Automatic download” is set. Refer to “5-2.Registering target system information” to set the 
automatic download function.
Automatic download is only performed when the PC the software is installed on is running. As the PC may not be running at the 
automatic download time, if more than one day has passed since the last automatic download, the notification area icon turns 
red.

Fig.6-1 [The notification area]
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7 The backup function
This function backs up the main data or power distribution data of the air-conditioner.

7-1. Registering target system information
When Report Creation Software is started up for the first time the target system is not registered. Follow the procedure below 
to register the target system.

1 Click the [Backup setting] menu item on the main screen to display the new registration screen.

Fig.7-1 [Tools menu (Backup setting)]

Fig.7-2 [The system registration screen]
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2 Enter the items (No.1 to 4) of the system to be backed up.
The following table shows how to enter / select each item:

Table.7-1 [Input / selection method for the items]

3 Click the [Check the connection] button / [Check the connection] menu item to check the 
connection for the target system.
If the connection is established successfully, the monthly report closing date and time are set.

Fig.7-3 [System registration screen (Check the connection button)]

Fig.7-4 [Run menu (Check the connection)]

4 To perform automatic backup, select the items.
Select “Daily”, “Weekly” or “Monthly” for the automatic backup interval.
• “Daily”: Enter the backup time.
• “Weekly”: Select the backup day of the week from the combo box and enter the backup time.
• “Monthly”: Select the backup day from the combo box and enter the backup time.

Automatic backup is only performed when the PC that the software is installed on is running.

No. Item Data type Input / selection method

1 System Entered by user –

2 Type Selected by user Selected from list

3 Model Selected by user Selected from list

4 IP Address Entered by user Number input

5 Daily report closing time Cannot be entered

6 Monthly report closing date Cannot be entered

7 Automatic backup Selected by user

8 Date and time for 
automatic backup

Interval Selected by user Select “Daily”, “Weekly” or “Monthly”

Daily Entered by user Enter the backup time

Weekly Selected and entered 
by user Select the backup day of the week and enter the backup time

Monthly Selected and entered 
by user Select the backup day and enter the backup time

9 Backup folder Entered by user Enter directly or use the [Browse] button

Click the button
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5 If there are any errors in a registration item, an error icon appears in that item.
Hover the mouse over the error icon to view the error message.

Fig.7-5 [Error icon (when no system is set)]

6 When all of the items are entered properly, you can click the [Register] button / [Register] menu 
item.
Click the [Register] button / [Register] menu item to register the system information.

Fig.7-6 [System registration screen (Register button)]

Fig.7-7 [File menu (Register)]

7 Click the [Close] icon / [Close] menu item to close the system registration screen.

Fig.7-8 [System registration screen (Close icon)]

Fig.7-9 [File menu (Close)]

Error icon

Error message

Click the button

Click the icon
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8 If the system information is still being entered, a confirmation message appears.
If the [Yes] button is clicked, the entered information is discarded and the system registration screen closes.

Fig.7-10 [Confirmation message]
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7-2. Adding a target system
Follow the procedure below to add a new target system.

1 Click the [Backup setting] menu item on the main screen to display a list of registered 
systems.

Fig.7-11 [Tools menu (Backup setting)]

2 Click the [New] button / [New] menu item in the registered systems list screen to display the new 
registration screen.

Fig.7-12 [List display screen (New button)]

Fig.7-13 [Edit menu (New)]

Refer to “7-1.Registering target system information” to add the target system.

Click the button
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7-3. Editing a target system
Follow the procedure below on the registered systems list screen to edit the target system.

1 Select the target system to edit.

Fig.7-14 [The List display screen]

2 After selecting, click the [Edit] button / [Edit] menu item to display the edit screen.

Fig.7-15 [List display screen (Edit button)]

Fig.7-16 [Edit menu (Edit)]

Refer to “7-1.Registering target system information” to edit the target system.
When Details is selected, the system whose details are being displayed will be edited.

Select the target system to edit.

Click the button
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7-4. Deleting a target system
Follow the procedure below on the registered systems list screen to delete a target system.

1 Select the target system to delete.

Fig.7-17 [The List display screen]

2 After selecting the system, click the [Delete] menu item.

Fig.7-18 [Edit menu (Delete)]

3 A delete confirmation message is displayed before deleting.
To delete, click the [Yes] button. The selected system will be deleted.
To cancel, click the [No] button.
When Details is selected, the system whose details are being displayed will be deleted.

Fig.7-19 [Delete confirmation message]

Select the target system to delete.
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7-5. Changing the display format of the registered systems list
There are two display formats for the registered systems list.
• List display: Registered systems are displayed in a list.
• Details: Detailed information about the registered systems is displayed.

Fig.7-20 [The List display screen]

Fig.7-21 [The Details screen]
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Click the [List display] button / [Details] button to change the display format.

Fig.7-22 [Details screen (List display button)]

Fig.7-23 [List display screen (Details button)]

When several systems are registered, click the [Previous] button / [Next] button to change the system that is being displayed.

Fig.7-24 [Details screen (Previous button)]

Fig.7-25 [Details screen (Next button)]

Click the button

Click the button

Click the button

Click the button
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7-6. Performing manual backup
Select a target system and then click the [Backup] menu item to perform manual backup.

Fig.7-26 [The List display screen (Backup)]

Fig.7-27 [The Details screen (Backup)]

Select the target system to back up.
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8 Cautions

8-1. “** exception **” and “** no name **” on the monthly report screen
If the controller setting has been changed due to one of the following reasons, “** exception **” or “** no name **” may be 
displayed on the result display in the monthly report.

(1) The air conditioner was removed or moved, or the indoor unit group was changed.
(2) The tenant was changed.

In the case of (1), “** exception **” is entered for the air conditioner whose setting has not been changed yet.
For the air conditioner with “** exception **” entered, only the operation hours will be entered.
In the case of (2), “** no name **” is entered in the tenant name or area name for the previous tenant.
For the air conditioner with “** no name **” entered, the operating results will be entered.

Fig.8-1 shows an example with the following changes:
(1) One indoor unit in “TENANT-B” was removed.
(2) The tenant of the units “unit1-1-1” and “unit1-1-2” was changed from “TENANT-A” to “TENANT-C”.

Fig.8-1 [List sheet]
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9 License agreement
Before using “Report Creation Software” (hereinafter referred to as “this software”), read this software’s license agreement 
(hereinafter referred to as “this agreement”) carefully.
By using or installing this software in part or as a whole, you agree to be bound by the terms of this agreement.
If you (hereinafter referred to as “the user”) do not agree to the terms of this agreement, return it to the place of purchase without 
using or installing this software.

(1) Under this agreement, this software means a computer program that is accompanied by this agreement as a recording 
medium or file, plus any and all other data including electronic documentation provided. Data that is explicitly not contained 
in this software is excluded.

(2) Toshiba Carrier Corporation retains the ownership and intellectual property rights to this software. The user may use this 
software by agreeing to the terms and conditions of this agreement for purposes designated by Toshiba Carrier Corporation 
or agreed upon by Toshiba Carrier Corporation and the user.

(3) Toshiba Carrier Corporation owns the copyright to this software. This software is protected by copyright laws and 
international treaties.

(4) The user may duplicate and install this software for purposes described in the documentation for this software. The user 
shall immediately delete a copy of this software when it becomes unnecessary. Excluding the above case, the user shall not 
duplicate this software.

(5) The user shall make no attempt to reverse engineer, decompile, disassemble, or alter this software.

(6) The user shall not let any other users use this software over a local network or the Internet.

(7) The user shall not distribute, give, rent, lease, sell, or sublicense this software or the right to use this software to any third 
party.

(8) The user shall respect the intellectual property rights of this software. In addition, the user shall recognize that this software 
is confidential and avoid disclosing this software to any third party.

(9) The user agrees to comply with the Foreign Exchange and Foreign Trade Control Law, the Export Trade Control Order, the 
United States Export Administration Act and all applicable international and national laws and regulations that apply to this 
software directly or indirectly.

(10) The user is allowed to use this software as is without any explicit or implicit guarantee. No implicit commercial guarantees 
or specific purpose applicability guarantees apply. Toshiba Carrier Corporation has no responsibility to guarantee the quality 
or performance of this software. Toshiba Carrier Corporation has no responsibility whatsoever for any damage, loss, cost 
or expense, incurred by the user, arising from the use of this software.

(11) If the terms of this agreement are violated or this agreement is canceled, the user shall uninstall and remove this software, 
and return the recording media and files (including copies) to Toshiba Carrier Corporation.

(12) Toshiba Carrier Corporation reserves the right to terminate the use of this software and modify or improve this software at 
any time.

(13) This agreement will be governed by and construed in accordance with the laws of Japan. (However, the applicable law 
selection rules are excluded. Hereinafter the same shall apply.)
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